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Úvod

Začínáte-li pracovat s nějakým produktem, musíte předem vědět, zda je vhodný pro cíl, 
kterého chcete dosáhnout. Co všechno od něj můžete očekávat.

Vyhovuje-li nabízený produkt vašim představám, začne vás zajímat způsob jeho použití. 
Potřebujete znát, jak s tímto nástrojem zacházet, aby se váš záměr povedl. Během času 
budete zlepšovat svoje dovednosti v dané oblasti, a pak mnohé z vás napadne seznámit 
se s používaným produktem hlouběji. Budete hledat odpovědi na otázky začínající slovem 
proč.

Tento úvod, spolu s kapitolou 4. Návrh databáze, by vám měl sdělit, co produkt umož-
ňuje. Zbytek publikace je zaměřen hlavně na otázku, jak toho dosáhnout. Zájemci v něm 
najdou i odpovědi na svá proč.

Zaměřili jsme se na vytváření databázových aplikací v prostředí tenkého klienta. Tato 
část totiž bývá v různých knihách zmiňována pouze okrajově a programátor, který se 
z nejrůznějších důvodů rozhodne vytvářet aplikace v tomto prostředí, je nucen naučit se 
i klienta tlustého.
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Aplikace vytvářené pomocí programu Visual Studio jsou typu klient-server. Server je po-
čítač, na kterém je uložena databáze a který představuje datovou vrstvu. Jeho jediným 
úkolem je efektivní přístup k datům uloženým v databázi. Klient je počítač, který obsahuje 
vlastní aplikaci (předává příkazy pro server) a který, v případě tlustého klienta, představuje 
aplikační vrstvu.

Tenký klient je další, třetí vrstvou. Došlo totiž k rozdělení aplikační vrstvy na funkční 
a prezentační. Jedná se o vizuální část s minimální funkcionalitou omezenou na rychlé 
ošetření vstupů a na vizualizaci dat. Vlastní funkcionalita je na aplikačním serveru a její 
část může být až na databázovém serveru. Jak je vidět, pojem tenkého klienta je úzce 
spjat s trojúrovňovou architekturou. V našem konkrétním případě se jedná o webový 
prohlížeč na straně tenkého klienta.

Při práci s tenkým klientem jste omezeni možnostmi webového prohlížeče, tj. možnostmi 
HTML. Ten neumožňuje využití všech ovládacích prvků Windows. Jaký smysl má vlastně 
použití tenkého klienta, když jeho možnosti z pohledu uživatele jsou menší? Hlavní vý-
hoda spočívá v údržbě a v instalaci u uživatelů. U klientských počítačů stačí, když mají 
nainstalován webový prohlížeč. Instalovat aplikaci tedy znamená, že uživatel obdrží pouze 
webovou adresu stránky, ze které se má aplikace vyvolat, a ta je tím nainstalována. Údržbu 
aplikace pak stačí provádět pouze na aplikačním serveru. Nároky na počítače u uživatelů 
mohou být též menší.

V této publikaci budeme vytvářet typickou databázovou aplikaci, která by vás v průbě-
hu její tvorby měla seznámit se všemi podstatnými částmi týkajícími se Visual Studia při 
hromadném zpracování dat. Po jejím přečtení byste měli být schopni vytvářet databázové 
aplikace, pracující s několika vzájemně provázanými tabulkami.

I když se budeme snažit své programy neustále zdokonalovat podle toho, jak porostou naše 
znalosti, neznamená to, že následující program bude vždy zahrnovat všechny dosud získané 
poznatky. Na stránce DPH.aspx se například seznámíme se způsobem, jak ověřovat data 
dříve, než se je pokusíme zapsat do databáze. V následujících programech se k nim ale už 
nevrátíme. Chceme totiž aby program zůstal přehledný a aby obsahoval pouze probíranou 
funkčnost. Při psaní skutečné aplikace byste ovšem měli data ověřovat vždy.

Simulovali jsme situaci, kdy na začátku je pouze vhodný počítač a na konci je aplikace 
„Fakturace“, kterou jste schopni distribuovat. Aby tvrzení, obsažená v této knize, odpo-
vídala realitě, nainstalovali jsme na prázdný počítač program Visual Studio .NET a začali 
jsme vytvářet ukázkovou aplikaci, která by vás měla průběžně seznamovat se všemi 
podstatnými částmi tohoto produktu, jež jsou nutné při vyvíjení robustních databázových 
aplikací. Současně vznikala tato publikace. Zaznamenávali jsme do ní všechny situace, 
se kterými jsme se v průběhu vývoje naší úlohy střetli, i když se netýkaly přímo Visual 
Studia .NET. V případě, že bylo třeba rozhodnout se mezi efektivitou pro uživatele a jed-
noduchostí z hlediska programátora, volili jsme jednoduchost. Protože jednoduchost je 
spojena s vizuálním programováním, dáváme přednost i vizuálnímu programování. Toto 
slovo je ostatně obsaženo i v názvu produktu. Efektivní programy mají tu nevýhodu, že 
jsou náročné na údržbu.

Jednotlivé příkazy, prvky apod. jsme uváděli tak, aby nebyly použity samoúčelně, ale 
v kontextu s vytvářenou aplikací.

Vzorová databáze „Fakturace“ obsahuje pouze 5 tabulek (z nichž jedna představuje tabulku 
parametrů), na kterých jsme se snažili ukázat základní vazby, se kterými byste měli uspět 
i při vytváření vazeb složitějších.

Ukázková aplikace provádí evidenci došlých faktur s vazbou na číselník organizací. U faktur 
evidujeme i řádky, které mají vazbu na číselník přijatých zdanitelných plnění. Faktury jsou 
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číslovány vzestupnou řadou s tím, že poslední číslo faktury udržujeme v parametrickém 
souboru. Mezi fakturami a číselníkem organizací je použita neidentifikační vazba, mezi 
fakturami a řádky vazba identifikační. Tato aplikace by mohla sloužit jako evidence DPH 
nebo jako vstup do účetnictví.

V první části publikace se ještě nepředpokládá, že jste seznámeni s logikou práce ve Visual 
Studiu. Proto jsme zvolili strategii „přilepování“ funkčnosti. Výsledný program vznikne 
po několika průchodech programováním. Při prvním průchodu se spokojíme s pouhým 
překladem zatím nefunkčního programu, v dalším pak se zobrazením dat a po dalším 
rozvíjení programu se dostaneme ke konečnému kroku s hotovou funkční aplikací pro 
aktualizaci. Vzhledem k tomu, že jednu a tutéž věc lze mnohdy řešit několika způsoby, 
snažíme se např. aktualizaci provádět pokaždé jinak. Při tvorbě profesionální aplikace by 
měly mít všechny programy stejnou formu. 

V další části, kdy již předpokládáme, že základy práce ovládáte, budeme postupovat přesně 
obráceně. Ukážeme si výsledný program a potom rozebereme jeho jednotlivé části.

Publikace je určena pro všechny programátory, kteří již pracovali s nějakým jazykem 
(včetně programování v DOS) nebo alespoň tuší co to je podmínka, cyklus či sekvence, 
kteří mají představu co je SQL a kteří zběžně ovládají Windows. Po přečtení byste měli 
být schopni napsat robustní databázovou aplikaci s využitím transakcí.

Vzhledem k tomu, že tato kniha má formu učebnice, čtěte ji souvisle tak jak je napsána. 
V každé kapitole se totiž seznámíte s určitými pojmy, znalostmi a postupy, na něž pak 
budeme navazovat. Vysvětlíme-li si například postup jak „Nakonfigurovat SqlDataAdapter“, 
nebudeme tento postup znova vysvětlovat, pouze uvedeme „Nakonfigurujte SqlDataAdap-
ter“. Na konci každé kapitoly se budeme snažit vás na nové pojmy, znalosti a postupy 
upozornit. 

Doporučujeme též, abyste si po každé části zkusili samostatně vytvořit svůj vlastní příklad. 
Naučíme-li se například jak vytvořit tabulku, zkuste si podle uvedeného postupu zhotovit 
svojí vlastní tabulku.

Úvod

®
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1. Nová aplikace (projekt)

Nová aplikace (projekt)

1.
V této kapitole se naučíme, jak vytvořit novou aplikaci, přeložit ji a vzápětí vyvolat. 
Vzhledem k tomu, že tato publikace je zaměřena na tenkého klienta, bude naše aplikace 
prezentována webovou stránkou. Její snadné rutinní volání umožníme prostřednictvím 
programu Microsoft Internet Explorer tím, že ji zahrneme mezi oblíbené položky. I když 
aplikace v této kapitole nebude mít zatím žádnou funkčnost, uvedený postup využijeme 
i při vytváření složitějších aplikací. V prostředí Visual Studia se aplikace nazývá projekt, a 
proto budeme používat i toto označení. Pojem aplikace budeme používat v uživatelském 
smyslu, pojem projekt ve smyslu vývojářském.

Projekty ve Visual Studiu mohou být různých typů. V následujících kapitolách jsme vybrali 
jako typ projektu Visual Basic Projects, neboť se nám zdál nejsrozumitelnější pro všechny 
ty, kteří mají zkušenost s nějakým jiným jazykem. Programátoři C si pravděpodobně vy-
berou typ projektu Visual C#.

Po vyvolání Visual Studia se zobrazí posledně použité 4 projekty (jestliže existují). 
Programátor má možnost vyvolat již existující projekt nebo vytvořit projekt nový. Pro-
tože právě začínáme a budeme vytvářet nový projekt, stiskneme tlačítko New Project. 
Dále, po stisknutí tlačítka OK, se zobrazí dialogové okno pro výběr již zmíněného typu 
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projektu (viz obrázek 1.1). V závislosti na typu projektu lze vybrat i typ zobrazení (šab-
lonu), kterým se budou prezentovat data na obrazovce – Template. Protože vytváříme 
projekt ve Visual Basicu, vybereme Visual Basic Projects a pro již zmíněného tenkého 
klienta vybereme následně aplikaci ASP.NET Web Application. V rozvíracím seznamu 
je zobrazen navrhovaný název projektu spolu s umístěním. Obsluha má možnost ten-
to název i umístění změnit. Rozhodli jsme se změnit pouze název. Protože vytváříme 
aplikaci pro evidenci přijatých faktur, přepsali jsme navrhovaný název http://localhost/
WebApplication1 na http://localhost/fakturace.

Označení projekt je v tomto případě poněkud nepřesné. Nejedná se 
totiž o projekt, ale o řešení (solution). Obecně může totiž řešení ob-
sahovat více projektů, i když v případě této publikace bude obsahovat 
vždy pouze jediný. Toto „nepřesné“ označení jsme použili proto, že 
je použito na úvodní obrazovce ve Visual Studiu. Jak ukazuje obrá-
zek 1.1, používají se termíny  New Project, Open Project, Open an 

Existing Project, ale ve skutečnosti se jedná o řešení.

Obr. 1.1: Výběr typu projektu

Po stisknutí tlačítka OK se zobrazí pracovní plocha pro návrh první webové stránky (viz 
obrázek 1.2). V horní části (tak jako u všech produktů Microsoft) jsou pod panelem 
nabídek (MenuBar) umístěny panely nástrojů (Toolbars). Pod panely nástrojů jsou 
umístěny záložky jednotlivých stránek (v našem případě zatím pouze již zmiňovaná pra-
covní plocha navrhované webové stránky s názvem WebForm1.aspx a úvodní stránka 
Visual Studia Start Page). Po levé straně je minimalizované okno Toolbox a ve spodní 
části je záložka s dotazem na způsob zobrazení pracovní plochy stránky. Pracovní plocha 
každé navrhované webové stránky může být totiž zobrazena ve dvou režimech (modech), 
a to buď v režimu Design, nebo v režimu HTML. Změny provedené na jedné záložce se 

Po
známka
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Obr. 1.2: Pracovní plocha pro návrh webové stránky v režimu Design

Obr. 1.3: Pracovní plocha pro návrh webové stránky v režimu HTML

1. Nová aplikace (projekt)
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okamžitě promítají do druhé záložky a vy si můžete vybrat, ve kterém režimu si přejete 
pracovat. My budeme pracovat v návrhovém režimu (Design), který zobrazuje pracovní 
plochu v takové podobě, jaká bude po vyvolání stránky uživatelem, nicméně pro ilustraci 
si zobrazíme i režim HTML (viz obrázek 1.3). Měl-li by vás zobrazený režim HTML odra-
dit od dalšího čtení, nemusíte se ničeho bát. Můžete se bez něj obejít. Zvláště nyní, když 
s Visual Studiem teprve začínáme.

Ukážeme-li myší nad již zmíněný Toolbox, „vyjede“ tento do strany, zvětší se a zobrazí se 
nám jeho nabídka (viz obrázek 1.4). Pomocí okna Toolbox můžeme umístit na pracovní 
plochu různé prvky, jako jsou například pole pro vstup údajů TextBox, políčka pro za-
škrtnutí CheckBox sloužící pro zadávání voleb, seznamy ListBox, přepínače RadioButton 
pro alternativní zadávání voleb apod. Komu nevyhovuje tento způsob práce s oknem 
Toolbox, může okno Toolbox přetáhnout na pracovní plochu, na které bude otevřené 
stále. Pomocí myši lze upravit jeho velikost a umístění.

Okno Toolbox přetáhnete na plochu tak, že po jeho „vyjetí“ stisknete tlačítko AutoHide, 
které se nachází vedle křížku v záhlaví okna Toolbox, a pak jej uchopením přetáhnete na 
zvolené místo (viz obrázek 1.5). Tím se dostane do režimu Float. V záhlaví tohoto okna 
můžete nastavit i další vlastnosti. Podaří-li se vám okno Toolbox zavřít nebo pokud se 
vám na pracovní ploše neobjeví, vyvolejte ho zadáním příkazu View → Toolbox.

Projekt přeložíme a spustíme, i když zatím ještě nic neumí. Překlad provedeme tak, že 
klepneme na příkaz Build (pátá volba) a potom na libovolnou 1. až 4. položku z nabídky. 
My jsme jej vyvolali příkazem Build → Build Fakturace (viz obrázek 1.6).

Obr. 1.4: Okno Toolbox na pracovní ploše v režimu AutoHide
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Obr. 1.5: Okno Toolbox na pracovní ploše v režimu Float

Obr. 1.6: Překlad projektu

1. Nová aplikace (projekt)
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Při překladu se projekt uloží i v tom případě, že obsahuje chyby. Ne-
ukončíte-li Visual Studio, lze použít tlačítek  Undo/Redo.

V okně Output (viz obrázek 1.7), kte-
ré se při vyvolání překladu objeví, se 
zobrazí průběh a výsledek překladu. 
(Všimněte si, že se k oknu Toolbox 
automaticky vytvořila nová záložka.) 
Bude-li projekt obsahovat nějaké 
syntaktické chyby, zobrazí se jejich 
seznam právě v tomto okně. Máte-li 
okna Toolbox a Output umístěna vzá-
jemně nezávisle, uchopte jedno okno 
pomocí myši a pokuste se ho umístit 
nad druhé okno. Při troše štěstí se 
vám hned napoprvé podaří obě okna 
sloučit a pro jejich vyvolávání se vytvoří 
záložky. Sloučí-li se vám jinak, okno 
opět vytáhněte stranou, upravte jeho 
velikost a zkuste to znovu. Podobným 
způsobem můžete nastavit zobrazení 
i dalších oken sloužících vývojáři, které 
je možné vyvolávat z panelu nabídek 
a se kterými se později setkáme. Nepo-
daří-li se vám požadované okno umístit 
do záložky, zkontrolujte zda nemá ve 
vlastnostech nastaveno Floating. Je-li tomu tak, zaškrtněte volbu Dockable. Vlastnost okna 
nastavíte tím, že umístíte kurzor do záhlaví okna a stisknete pravé tlačítko.

Jak ukazuje obrázek 1.7, jsou okna Toolbox i Output sloučena. Obě se dají zavřít klepnutím 
na křížek v pravém horním rohu. Potřebujete-li zavřít pouze jedno z nich, klepněte na záložku 
tohoto okna, aby se stalo aktivní, uchopte toto okno a potáhněte jej stranou. Okno by nyní 
mělo být na stránce umístěno samostatně. Poté ho můžete zavřít. Později, až se seznámíme 
s dalšími okny (v panelu nabídek pod volbou View), budete postupovat obdobně.

Po úspěšném překladu můžete projekt vyvolat. To proveďte příkazem File → View 
in Browser (viz obrázek 1.8). Ve skutečnosti můžete předcházející krok (tj. Build) pře-
skočit a vyvolat přímo View in Browser. Překlad se vyvolá sám. Měla by se vám zobrazit 
následující stránka (viz obrázek 1.9). Naše aplikace sice zatím nic neprovádí, ale to, co je 
nejdůležitější (překlad a vyvolání stránky), již umíme.

Jestliže jste nezavřeli okna Toolbox nebo Output, budou v případě spuštění tímto způso-
bem též zobrazena. Kromě této stránky jsou vidět i záložky všech otevřených stránek ve 
Visual Studiu. V našem případě zatím jen záložky stránek Start Page a WebForm1.aspx. 
Zapamatujete-li si adresu webové stránky (URL adresu), která by měla být vidět v rozví-
racím seznamu ve spodní řadě panelu nástrojů, nebo ji stiskem klávesové zkratky CTRL+C 
dáte do paměti, můžete tuto webovou stránku přidat do oblíbených položek a volat ji 
přímo z Internet Exploreru. Zavřete tedy stránku nebo celé Visual Studio (podle toho, 
který křížek stisknete), vyvolejte Internet Explorer, jako adresu napište URL adresu (nebo 
ji vložte pomocí stisku klávesové zkratky CTRL+V). V našem případě se jedná o adresu 
http://localhost/Fakturace/WebForm1.aspx. Po stisknutí klávesy ENTER se zobrazí následující 
stránka. Přidejte ji do oblíbených položek (viz obrázek 1.10).

Po
známka

Obr. 1.7: Okno Output
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Obr. 1.8: Vyvolání projektu

Obr. 1.9: Zobrazení stránky projektu

1. Nová aplikace (projekt)
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Obr. 1.10: Zařazení stránky projektu mezi oblíbené položky

Není-li řádek s URL adresou viditelný, je to způsobeno nastavením 
Visual Studia. Pravděpodobně je v nabídce  View nastavena volba 
Full Screen.

Čtenáři obvykle očekávají, že první kapitola obsahuje program, kte-
rý dokáže napsat „Hello, world!“. Náš první program, resp. webová 
stránka, to nedělá. Je to dáno koncepcí této knihy, neboť tato webová 
stránka bude v další kapitole použita. V našem případě by se tedy 
jednalo o „slepou uličku“. Naučili jste se však, jak se vytváří nový 
projekt, jakým způsobem se překládá a vyvolává přeložená webová 
stránka, jakým způsobem ji lze zahrnout do internetového prohlížeče 
a jak ji z něj vyvolávat.

Budete-li příště otevírat již existující projekt, a ten se bude vyskytovat 
mezi posledními čtyřmi nabízenými projekty, klepnete pouze na jeho 
nabízené jméno. Nebude-li v nabídce obsažen, klepnete na tlačítko 
Open Project a standardním způsobem, prostřednictvím dialogového 
okna, projekt vyhledáte.

Ještě než přejdete k další kapitole, zkuste tento projekt otevřít, znovu 
přeložit a vyvolat. Zároveň zkuste naší nově vytvořenou stránku z to-
hoto projektu vyvolat i z oblíbených položek.

Při překladu jste si možná všimli, že kromě příkazu  Build → Rebuild 
projektu  Fakturace se ve stejné nabídce objevuje i příkaz  Build →

Po
známka
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Rebuild Solution. Řekli jsme si, že každé řešení bude obsahovat jedi-
ný projekt. Proto lze překlad vyvolat libovolnou volbou. O řešení zatím 
stačí vědět, že je zde uložen poslední stav zobrazení vašeho projektu 
(případně vašich projektů). Po otevření řešení se tedy zobrazí všechny 
stránky, okna i záložky tak, jako když jste projekt naposled zavírali.
Jak vytvořit projekt.

9 Jak přeložit projekt.

9 Jak vyvolat stránku projektu.

9 Jak zahrnout projekt mezi oblíbené položky.

9 Co je to okno Toolbox.

9 Co je to okno Output.

9 V jakém režimu může být stránka zobrazena.

Za
pa
matujte si

1. Nová aplikace (projekt)
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2. První funkční aplikace – volání stránek

První funkční aplikace – 
volání stránek

2.
Stránka, kterou jsme vytvořili v předcházející kapitole, bude v naší aplikaci sloužit jako 
menu, ze kterého se budou prostřednictvím hypertextových odkazů volat další stránky. 
Bude představovat hlavní stránku. Z ní se budou vyvolávat například stránky pro aktuali-
zaci číselníku organizací, pro DPH, pro zaevidování faktur apod. V této kapitole vytvoříme 
další novou stránku, která bude v následujících kapitolách sloužit k aktualizaci číselníku 
organizací, a obě stránky mezi sebou propojíme. Ani v této kapitole se neseznámíme 
s žádným programovým kódem.

Vzhledem k tomu, že jsme Visual Studio zavřeli, musíme jej znovu otevřít. Ve výčtu posled-
ních čtyř projektů by se měl náš projekt již nacházet, proto na něj přímo klepneme. Protože 
při ukončení práce s Visual Studiem jsme měli otevřené záložky oken Output a Toolbox, 
zobrazí se nám tato okna i při otevření projektu (viz obrázek 2.1).

Po klepnutí na projekt Fakturace by se vám měla objevit webová stránka WebForm1.aspx 
(tj. stránka, kterou jsme měli v projektu Fakturace naposled otevřenou).

Není-li tomu tak (stránku jste předtím třeba zavřeli) musíte ji znovu otevřít. Po vyvolání 
příkazu View → Solution Explorer (viz obrázek 2.2) se objeví další okno (pravděpodobně 
se samo zařadí do záložek k již zobrazeným oknům Toolbox a Output), ve kterém je 
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Obr. 2.1: Otevření existujícího projektu

Obr. 2.2: Otevření okna Solution Explorer



VISUAL STUDIO .NET 25

Pr
vn

í f
un

kč
ní 

ap
lik

ac
e 

–
vo

lá
ní 

st
rá

ne
k

2. První funkční aplikace – volání stránek

zobrazena struktura vaší aplikace (viz 
obrázek 2.3). Poklepáním na požado-
vané stránce (v našem případě tedy na 
stránce WebForm1) se zobrazí webová 
stránka v režimu Design. Ostatní strán-
ky byly vygenerovány Visual Studiem 
při vytvoření nového projektu a my si 
jich zatím nebudeme všímat (a raději 
ani v budoucnu). I když je stránka 
WebForm1.aspx otevřená, vyvolejte 
okno Solution Explorer stejně, neboť 
ho budeme potřebovat.

Jak jsme uvedli na začátku této kapito-
ly, vytvoříme nyní novou stránku. To 
lze provést např. tak, že v okně Solu-
tion Explorer klepneme pravým tlačít-
kem na složku Fakturace a z nabídek 
vybereme Add → Add New Item (viz 
obrázek 2.4). Musíte dbát na to, aby 
kurzor byl skutečně na složce Fakturace. Pokud byste myší klepli např. na stránku Web-
Form1, následná nabídka se nezobrazí, resp. zobrazí se s jiným obsahem.

Obr. 2.4: Vytvoření nové stránky

Pomocí dialogového okna vyberte ikonu WebForm, nabízený název WebForm2 přepište 
na CiselnikOrganizaci.aspx a stiskněte tlačítko Open (viz obrázek 2.5). Novou stránku 
lze vytvořit i rychleji, vyberete-li místo Add new item přímo Add Web Form.

Obr. 2.3: Okno Solution Explorer
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Pro vytváření stránek lze použít průvodce WebFormWizard, který umožňuje vytvářet strán-
ku pomocí sekvence dialogových oken. Domníváme se, že pro profesionální programování 
jsou tito průvodci nepoužitelní, a tak se o nich ani nebudeme zmiňovat.

Obr. 2.5: Výběr stránky typu WebForm

Po stisknutí tlačítka Open se vytvoří 
nová stránka, která je zcela nezávislá 
na stránce WebForm1. Není ani de-
finováno, která stránka je hlavní (viz 
obrázek 2.6). Tuto stránku můžeme 
překládat a spouštět stejně jako strán-
ku vytvořenou v předcházející kapitole, 
můžeme jí zařadit do oblíbených polo-
žek, přestože jsou obě stránky součástí 
stejného projektu. Po překladu a vyvo-
lání se vždy zobrazí ta stránka, kterou 
jste měli otevřenou naposled. Můžete si 
to vyzkoušet, přidáte-li ji do oblíbených 
položek. Po odzkoušení ji z oblíbených 
položek zase vyjměte.

Nyní se pokusíme obě stránky spolu 
provázat. Zkusíme to pomocí hyper-
textových odkazů. Klepneme na zálož-
ku Toolbox. Nezobrazí-li se Toolbox 
v následující podobě, vyberte ze svis-
lých záložek okna Toolbox záložku 
WebForms a klepněte na ni. Vyberte 
prvek HyperLink, stiskněte levé tlačít-
ko, přetáhněte ho někam do levého horního rohu pracovní plochy a opět tlačítko uvolněte 
(viz obrázek 2.7). Vytvořili jste nový objekt, který byl pojmenován jako HyperLink1. Je 
odvozen od prvku HyperLink. Objekt HyperLink1 umožňuje volat námi požadovanou 
stránku. Aby tak mohl učinit, musíme mu nastavit určité vlastnosti. Vlastnosti libovolného 
objektu, a tedy i HyperLink1, se nastaví např. tak, že umístíte kurzor myši na vybraný 
objekt a stiskněte pravé tlačítko. Tím se vyvolá kontextová nabídka (viz obrázek 2.7). Vy-

Obr. 2.6: Okno Solution Explorer 
po přidání nové stránky


